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NetSkate    User Manual 

1 Getting Started 

 Hello, are you busy with something today? I need your help. 
 

:              Nothing specific to do for now. Tell me what can I do for you. 
 

Yes. I have a NetSkate package.   I have heard, you are familiar with  
NetSkate, I thought you could help me to Navigate through the Package and 
generate and display Local Network Maps. I understand that we can plot online 
graphs to monitor network traffic and also visualize interface and resources status. 
Apart from these, there is a feature called Reachability viewer, which is also 
explained graphically. 

             That sounds pretty interesting. Let us start right away. 
 

Here it is. I am told we can run this package on Windows/ MacOSX/and  
                          different flavors of Unix and Linux operating Systems. How do I install it? Can 
                          you guide me? 

  NetSkate Installation is very simple. You can refer to NetSkate Installation Guide. 
Even I learnt from this document. After Installation the NetSkate directory will 
be created. 
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OK. How can I start NetSkate.  Do I need to change the settings and configure 
the package? 

  To start NetSkate you need to start the NetSkate Server and NetSkate client. 
 For NetSkate client you need to set the policy. 

How can I do that. I have never done it before. 

  Oh! Its simple. You have to start the policytool. 
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PolicyTool? Where will I get it from. 

  Policytool is a standard application which comes along with java Package. 

OK. How can I use it. 
 
Adding Policy 
 

  Start the policytool from the commandline by typing 
policytool 

 
i. Click on the "Add Policy Entry" button 

ii. Enter the following value in the CodeBase field 
http://<server>/<location of OR link to directory in which netskate's index.html 
file is stored> 

iii. Click on the "Add Permission" button 
iv. In the Permissions dialog, select FilePermission in the Permission drop-down 

box. Select <<ALL FILES>> from the Target Name drop-down box. From the 
Actions drop-down box, select read, and then select write. Click on the "Ok" 
button. 

v. Click on the "Add Permission" button 
vi. In the Permissions dialog, select PropertyPermission in the Permission drop-

down box. 
vii. Enter user.home into the Target Name field.  

From the Actions drop-down box, select read. 
Click on the "Ok" button.  

viii. Click on the "Add Permission" button 
ix. In the Permissions dialog, select AWTPermission in the Permission drop-down 

box. Select accessClipboard from the Target Name drop-down box.  
Click on the "Ok" button.  

x. Click on the "Add Permission" button 
xi. In the Permissions dialog, select Runtime Permission in the Permission drop-

down box. In the Target Name field, select "queuePrintJob".  
Click on the "Ok" button. 

xii. Click on Save under the File menu. 
xiii. Save the settings in a file named .java.policy in your home directory. 
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1.1 Starting NetSkate Server  
The Server Manager is a UI based tool with which the NetSkate server can be managed. 
This tool displays the server status and the status of the client(s) connected to the server.  

 

 
Double clicking on the Server Manager Executable file will start the Server Manager.  
Alternatively it can be started from the command line also. This will start the Server in 
UI mode if the UI is accessible otherwise, the server is started in the console mode with 
no ServerManager UI. 
 
 

 
 
 

 
 

As the client(s) is started, the Client Status is displayed on the UI. 
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1.2 Starting NetSkate Client 
 

  Now that you have started the server, we can start the client. I just want to remind 
you that NetSkate Client can be loaded remotely also. It should be HTTP 
accessible.  
To start the NetSkate Client either double click on the index.html or use 
appletviewer to start the client.  

 
  
 

 
 

  Now, click on link with “NetSkate” marked on it. This will start up the NetSkate. 
Before we proceed, I want to caution you about one thing, be very attentive 
otherwise; you may not be able to follow. Okay now look; can you see a screen 
coming up? 

             Read the messages displayed inside the screen shots. 
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You should click “Yes” if you want to generate a local network map. An authentication 
window as shown below is displayed. 

 

 
 
 

Enter the User Name and the Password. Click Ok. The following screen is displayed  
(Note that if the authentication fails, NetSkate continues without generating the map and 
takes you back to the main window.) 
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You may enter a community name and click “Ok” to proceed with the specified value, or 
click “Cancel” to proceed with the default value. 

                  

               
 

The progress bar shows the status while the Package is loaded .The generated map will be 
displayed on the main panel when you select Map display from the view menu.  
We are going to generate the map in the Tutorial section also, but that will be from the 
Menu option/Tool bar.   
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That is a little lengthy procedure, but it is quite interesting. Can you show  
                           what  the NetSkate Main window looks like? 

    Here it is. It has the regular Menu bar, Tool bar and Status bar. I am sure you are  
                         familiar with these by now. 
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  Before we proceed, let me give a brief description of the Tool bar buttons and show the 
              Full Screen of the NetSkate. 
 

Tool bar 
 

 
 

    Invokes Graph dialog 
 

                               Invokes the Disk Status display.  
 

     Toggles Map Display Window 
 

     Toggles HTTP Reachability Viewer Window 
 

   Toggles  SNMP Reachability Viewer Window 
 

 

                              Quits the package. 
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FULL SCREEN 
 
A          Graph Window  E Tool Bar  I           Status Bar          
B Reachability Viewer F IP Table  J           Map display                     
C Logger Display  G Interface Status  K          Disk Status Pie chart  
D Menu Bar  H Disk Status Bar Graph L           Preference Dialog  
 
   A    B       C       D    E        F          G       H              I        J              K               L 
 

 

 Oh Good. That is Netskate displaying all the features .I am looking forward to   
                           know more about them. 

              The following sections will provide an overview of most of the above listed  
                          features. Shall we start generating a map and plot the graph? 
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I am just thrilled to know, that we are going to plot graphs. I have a fascination 
for graphs. Before starting can you tell me how to close NetSkate. 

1.3 Closing NetSkate Client 

              Closing NetSkate Client is simple. On the toolbar  

      
Quits the package. 
 

Hmm… But, then do I need to arrange all my graphs and windows again? 
 

 No. NetSkate client asks to save the screen settings and when starting the client 
again you can get your screen settings again. 
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1.4 Stopping NetSkate Server 

              After stopping all the client the server can be stopped using the server manager. 
 

 
 

 
 The server can be stopped by clicking on Stop Server Button. The server 

manager stops the Server.  
 

 
 
 

  The Exit button on File menu exits the Server Manger application. 
 

 

OK. Now can you please tell me about NetSkate functions and features? 

              Lets start. 
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2 Tutorial 
 
 

Since I had stopped the Server and Client. I restarted the NetSkate again. 
 Server is OK. But, this time client didn’t asked for Map Generation. 

 That’s because you already have a map. 

But, then this time I have a new window. What should I do? 

 
 

 You can use the screen, which was saved last time, or you can start with a fresh 
window. 

 

I remember the dialog, which had come while shutting down the client. But, this 
time I will start afresh. 
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I got a blank window. What should I do? 

 
 

 You can view your network map. 
 

2.1 Display a map  

How can I see a map? 

 You can do this by either using the tool bar or by using the view menu. Let me 
show you. 
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Oh it’s nice but what should I do with this map.  

 Map is the logical representation o your Network. You can see which machines 
are connected to which Network. 
The Tool bar has three options to enhance the utility of this feature. 
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Reload  

 
The local map, which is loaded as default map, can be reloaded 
by using Reload button. 

Interface status  

 

Checks the specified network element for the SNMP 
access/ICMP reachability and indicates the status using colour 
codes as, 
 

 

  

SNMP accessible: green 

   

 SNMP not accessible: red 

Map Statistics display 

 
The statistics of all the Nodes in the currently loaded map can be 
viewed by clicking on this button.  

 
 

What does SNMP accessible and not accessible mean? 

 If the host is SNMP accessible you can see the Traffic on that host. 

Did you said Traffic. How can I see the traffic? 

 You can not only see it using IP Table but, you can plot it also using Grapher. 
Let me show you how simple this is. 
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2.2 IP Table 

 On IP Table you can see the traffic statistics for different systems. 
 Not only this you can see the current In / Out Traffic on a logarithmic scale. 
 

 
 

Can you tell me what else is there on this table. 

 IP Table displays the IP Address of the machine, MAC Address. Min Max and 
Average Traffic. 
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You were telling me that we could plot this on Graphs also. 

 We are going to do that only. 

2.3 Online Graph 

 Select Online/Offline graph from the Tools menu. 
 

 
 

A graph dialog is displayed. You have to enter the data in the fields. The data can also be 
selected from the drop down menus. Click ‘Show’. The graph is plotted and displayed. 
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 Now that the graph is plotted, we will see how to use the toolbars of the Graph 
window and the Graph control bar and the side bar. 

 
Graph Tool Bar 

 
Add new graph   

 
 

 
Click this button to add a new graph.  
 

Change Color  

 Provides options to change the colours  
Start button  

 
Click this button to start plotting the graph. Changes to “Stop 
button”, when clicked. 

Stop button  

 
Click this button to stop plotting the graph. Changes to “Start 
button”, when clicked. 

 
 
 

Graph Control Bar 
 

                           
 
 

    These buttons will assist you to scroll the graph to the left, right, Zoom in and Zoom out. 
 
 

Graph Side Bar 

 

All the graphs added have a control button on the Graph Side 
Bar. The button having the same color of the graph represents 
them. You can toggle this to display/hide graphs as per need. 

Is this data stored somewhere. 

 Oh yes. This is stored on the server.  
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Aah! It would be great if I could see this data later also. 
 

 NetSkate has taken care of this also. You can see it as Offlien Graph. 
 

2.4 Offline Graph 

 You can plot the offline Graphs using the same Dialog. 

So how will I ask for Offline Graphs then? 

 When we plotted Online Graph, we had placed a check mark on the “From now” 
Checkbox.(Refer Graph Dialog) Simply uncheck this box. You will notice that 
‘From’ and ‘To’ fields are enabled. Insert the dates in the specified format 
DD/MM/YYYY. 
Select ‘Show’ from the Graph Dialog. 

 
 
 

 
 

 If there are no data the following message is displayed. 
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In the Graph Dialog Interface Name is there. Can I see the Interface Status also. 
 

 Oh yes. You can see the Disk Status and Interface Status also. 
 

2.5 Visualize Disk & Interface Status 

2.5.1 Interface Status 

 This displays all the interfaces associated with the host. 
Right click on a PC icon on the map. A context menu is displayed. Select 
Interface Status from this menu.  
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. 
 

 
The interface status is displayed for this host.  
 

 

2.5.2 Disk Status 

 By Disk Status we mean the resource usage of a host in the network. We are 
going to display graphically, the status of the Disk-the availability of disk space, 
used portion of the Disk etc.of a particular host. Select Disk Status from the 
Tools menu. 

 

 
 

 Disk Status dialog window is displayed. 
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 Disk Status dialog window is displayed. 
Enter the Host name and community.  
You have an option to view the Disk status as Pie chart or Bar graph or both. 
Select the display type and click ‘Show’ Bar Graph and pie charts are displayed  

 

 
                                                  Bar Graph                                                     Pie Chart 

 

Hmm. I did not know that map could give me so much of information. But, I 
have a doubt. What if I add new machines to my network or remove some 
machines from network. 

 

 Oh you can always regenerate map. 
 

Can I regenerate the map also? Tell me how can I do that 
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2.6 Generate and Display a map           

    Select Generate Local Network map from View menu. 
 

 
 

 
Map Generation Authentication dialog is displayed.  

 

 
 

Fill in the Username and Password. Click on OK button. 
A dialog window prompting you to enter the community name is displayed 

 

 
 
click on ‘OK’. The application will take the default value and continue to generate the 
map. During the generation process ‘User Approval’ dialog is displayed.  
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Select the Hosts that should be polled. and click ‘Go’. The map generated is displayed 
below  
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What else can I do? 

 You can use Reachability viewer to see how the reachability of your Host and 
The time taken to reach by the specified URL is represented graphically. 

How can I do that? 
 

2.7 Reachability viewer 

2.7.1 HTTP 
  

              Select the reachability viewer from the Tools menu.  

 
 
             The bar graphs for URLs present in the file urls.lst are displayed.  
             Maximum time is denoted by Red color, Minimum by Yellow, and Average time by Blue  
             color. The current time taken is shown by Cyan. 
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If you need to edit a URL list, then select the icon from the tool bar of this window and. 
an authentication dialog is displayed. You have to enter the User name and Password and 
click Ok.  

 

 
 

 
 

The Reachability Viewer List Edit window is displayed  
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When you select ‘Save’ the data is saved. If you want to quit the application you can 
select ‘Save & Exit’. ‘Cancel’ will quit the window. 
 

How can I see reachability of my host? 

              You can use SNMP Reachbility viewer. 
 

2.7.2 SNMP 
 The time taken by the Snmp queries to the specified host is represented graphically. 

             Select theSnmp reachability viewer from the Tools menu. 

 
 

 
             The bar graphs for hosts are displayed.  
             Maximum time is denoted by Red color, Minimum by Yellow, and Average time by Blue  
             color. The current time taken is shown by Cyan. 
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3 How-To 

3.1 Network Status 
 
 
 

                                                  
                                                                   
                                                                                              

It is very simple, 
Open Map Display and IP Table. 
On Map Display you can see the, 
Status of PCs and other elements. 
On IP Table you can see the traffic 
statistics for different systems. 

How can I know my 
Network status? 
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3.2 Host Status 
 
 
 
 

                             
 

 

Didn’t I tell you Map Display is one nice and 
easy feature? 
 
Open Map Display and from the context 
menu of PC elements select System details 
and Interface status. 

How can I check the 
status of a host? 
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3.3 Host-Traffic 
 
 
 
 
 

                                       

Using the best Grapher tool around. See, 
NetSkate has it. 
 
Open GraphDialog and specify your host 
details and click Show. Voila! Grapher 
will plot the traffic of your hosts. 

How can I see the 
traffic of my hosts? 
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3.4 Network –Connection Status 
 
 

Tell me how do I check if 
my host is really 
connected to the Internet?

Use the HTTP/Snmp 
Reachability Viewer. 
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3.5 Add New Host 
 
 
 
 
 
 
 
 

 

            

Run “Generate Local Network Map” 
from View menu. This will update the 
map and after the map generation is 
complete you will see the new hosts in 
the map. 

There are some new hosts 
added to my network. How 
do I add these to my current 
map? 

 

 
 
After Authentication dialog select some hosts from the User Approval Dialog. 
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You will see that only three hosts are there in the first map. The second map shows 
additional hosts. 

 
 
 

3.6 Preference 
 
 
 
 
 
 
 
 
 
 

                                                         

Go to Edit menu. Select ‘Preferences’. 
There are three options to choose from.  
• Themes 
• Look& Feel 
• Map Display 
Screen Settings and other display features
Can be altered with this utility. 

Can you tell me something 
about the menu option 
Preferences.? 
I understand this is a very 
useful utility in NetSkate.  
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 look ,in the screen shot displayed above, Themes is changed from Steel to Emerald. 

   In the following screen shots, Look & Feel has been changed from Java to Motif. 
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